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  Introduction 

We’re glad you will be applying for CSBG funding for Tribes and Tribal Organizations! 

The Community Services Block Grant (CSBG) program provides Native American and 

Alaska Native Tribes and Tribal Organizations with critical funds to address the causes 

and conditions of poverty in their communities. CSBG is a flexible block grant that can 

support a range of services and activities in response to community needs. Funding is 

provided directly to state and federally-recognized Tribes and Tribal organizations through 

the U.S. Department of Health and Human Services’ Office of Community Services (OCS). 

For more information, see our Introduction to the Community Services Block Grant (CSBG 

webinar materials.  

The CSBG Training & Technical Assistance Program for Tribes and Tribal Organizations 

has created the following guide to enable new and renewing CSBG Tribal grantees to use 

the CSBG Tribal Plan & Application Fillable-PDF Tool. The guide provides step-by-step 

directions for completing the fillable-PDF for an easy and seamless application process. 

Reminders: 

● All CSBG Tribal Plan and application materials are due by September 1 every year. 

● All CSBG Tribal Annual Reports are due by December 30 every year. 

All new and renewing applicants must submit relevant application materials. (Note: Tribal 

grantees in the middle of an approved two-year Tribal Plan must submit an updated SF-

424M by September 1st and Annual Report by December 30th every year in order to 

receive funding.) 

CSBG funding for each fiscal year is subject to the receipt and approval of all required 

CSBG application materials. 

As you work through the application, please remember that help is available anytime from 

the CSBG Tribal T/TA team at tribalta@luxcg.com or (301) 244-3557. 

Let’s get started! 

https://csbgtribalta.com/introduction-to-csbg-webinar/
https://csbgtribalta.com/tools/#1570647824255-6bc35c05-4007
mailto:tribalta@luxcg.com
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  Fillable-PDF Form Guidance 

Before you begin, please read through all of the following information carefully to ensure 

easy access to the fillable-PDF tools.  

Save the Fillable PDF-Tool to Your Computer Before Completing it! 

Please download and save the CSBG Tribal Plan & Application Fillable-PDF Tool to your 

computer or network drive. This will allow you to save your information and re-open the 

tool later to modify or enter additional information as needed.  

To download the file directly to your computer or to a disk: 

● Position your cursor on the tool link and click with your right mouse button. (To avoid 

entering “preview” do not activate the link and open the form.) 

● From the menu that pops up, select the “Save target as” option in Internet Explorer or 

the “Save link as” or similar option in another browser. 

● You will then be prompted to choose a location to save the file. 

● Select the location on your own computer or network and click on the “Save” button. 

● Make a note of the location on your computer and the name of the file being saved 

for easy access. 

From there, you can then open it with the free Adobe Reader program to complete the 

form. Adobe Reader is the only program that will allow you to work with the form properly. 

If you do not already have Adobe Reader, please use this link to install it to your machine 

for free. 

● To download or update to the most recent free version of Adobe Acrobat Reader, visit 

the Adobe® website. 

After you have downloaded and saved your fillable-PDF tools, open them with Adobe 

Reader and follow the instructions below to successfully complete forms. 

Complete the Forms 

Each fillable-PDF contains four types of interactive areas: 

● Checkboxes: To check a box, position your cursor over the square and click to mark 

your answer. 

https://csbgtribalta.com/tools/#1570647824255-6bc35c05-4007
http://get.adobe.com/reader/otherversions
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● Text boxes: Click your cursor inside the shaded text box and begin typing. You can 

either type information directly into each field or copy and paste from another 

document. There are no character limits. 

● Date boxes: To enter the date position your cursor in the shaded text box and enter 

the date using the following format: mm/dd/yyyy. (Example: 09/01/2020) 

● Signature lines: The CSBG Tribal Plan & Application Fillable-PDF Tool will request 

several original signatures for the form to be considered complete. While it is 

preferred that digital signatures are used in simplifying the reporting process, we fully 

understand that some offices and locations may have limited access to digital 

signature resources. Those who have digital signature resources may opt to use the 

Electronic Signature Process. Others may prefer to use the Manual Signature 

Process. Please choose the process best suited to your needs in signing your 

documents: 

○ Electronic Signatures: Grantees who choose to use the Adobe Acrobat for 

digital signatures/certified IDs please use the following directions: 

■ Fully complete all information and save your document before starting 

the digital signature process. To save, choose “File > Save As” on the 

Adobe Reader menu. You will then be prompted to choose a location to 

save the document. 

■ Note: If a change must be made after adding a digital signature, all 

previous signatures will have to be revalidated by the person who 

originally signed.) We recommend keeping a back-up copy just in case 

additional changes have to be made after the document is signed. 

Before adding signatures save the PDF under a new name so that you 

have a completed un-signed copy of the PDF to return to for any 

possible future edits. (Example “CSBG Tribal Plan & Application 

Fillable-PDF Tool – Complete 8.1.19”) 

■ If you need any assistance with electronic signatures, please feel free to 

reach out to the CSBG Tribal T/TA team for assistance at (301) 244-

3557. 

■ Have the Authorized Tribal Official(s) electronically sign all signature 

lines. To enter an electronic signature, position your cursor in the 

shaded text box. Follow the prompts for a “Certified Signature.” 

■ All signature lines must be signed for the application to be accepted by 

OCS. Signature lines can be found in the following sections: 

● Page 8 – line 1.5d 

● Page 18 – line 7.2c 

https://csbgtribalta.com/tools/#1570647824255-6bc35c05-4007
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● Page 31 – line 8.1c 

● Page 35 – line 8.2c 

● Page 40 – line 8.3c 

● Page 41 – line 8.4c 

■ Once all signatures have been added, save the signed PDF and update 

the file name. 

○ Manual Signatures: Grantees who choose to manually sign the required 

sections of the tool, please use the following directions: 

■ Fully complete all information and save your document before printing 

for signatures. To save, choose “File > Save As” on the Adobe Reader 

menu. You will then be prompted to choose a location to save the 

document. 

■ Print all pages of the tool. 

Once the pages are printed check your Text boxes. If any of your text has 

been cut off from the shaded text box area you will need to complete a Long 

Answer Addendum and attach it to your PDF Plan & application. 

■ Note: To complete a Long Answer Addendum contact the CSBG Tribal 

T/TA team for direct assistance at (301) 244-3557 or email at 

tribalta@luxcg.com. You will need to provide the T/TA team with your 

completed and saved PDF file. Once the Long Answer Addendum is 

complete the Tribal T/TA team will return your completed PDF with the 

Addendum. Save this file with an updated name. Print all pages of the 

completed tool. 

■ Have the Authorized Tribal Official(s) provide original signatures to all 

signature lines. 

■ All signature lines must be signed for the application to be accepted by 

OCS. Signature lines can be found in the following sections: 

● Page 8 – line 1.5d 

● Page 18 – line 7.2c 

● Page 31 – line 8.1c 

● Page 35 – line 8.2c 

● Page 40 – line 8.3c 

● Page 41 – line 8.4c 

mailto:tribalta@luxcg.com
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■ Once all signatures have been added, scan the entire signed document 

and save it as a .PDF file. Please do NOT save scanned documents as 

images. 

Save PDFs of the Additional Required Materials 

OCS requires that a few additional materials be attached to your completed CSBG Tribal 

Plan and Application. To follow are the required additional materials: 

● Public Hearing announcements 

● State Recognition documentation (only if citation of State statute was unavailable) 

● Tribal Resolution (only if representing more than one Tribe) 

Please Note: Returning grantees please do NOT upload a PDF version of the SF-424M 

form or a copy of the Federal Register into the OLDC System. 

Please save these additional materials as PDF files by scanning a document (if not 

already an electronic document) and choosing the File Format "PDF" in the “File > Save 

As” options. Documents should not be encrypted or password-protected. Please do NOT 

save scanned documents as images. 

Saving and Uploading Images 

Many CSBG Tribal grantees choose to share pictures of the great work the program is 

doing in their community. These pictures help showcase the CSBG stories in Native 

communities. If you choose to include pictures with your CSBG Tribal Plan and 

Application, please follow these quick steps: 

● Place all images in a Word Document 

● Save Word doc in the same location as your CSBG Tribal Plan. To save, choose “File 

> Save As”. File Type > PDF 

Combine all Final PDFs 

Please combine all final PDFs into one document, no larger than 10 MB. (This includes the 

completed and signed Tribal Plan and Application, Additional Required Materials, and any 

Additional Optional Materials.) To combine your materials into one PDF you will need to 

have access to Adobe Pro or Adobe Pro DC software. These are not free programs. If you 

do not have access to these programs, please contact the CSBG Tribal T/TA team for 

direct assistance at (301) 244-3557. 

● Combine all materials before adding electronic signatures, 



 
 

CSBG Tribal Plan and Application Tool Guide 
 

8 

● Open all PDF documents (the completed Tribal Plan and Application, combined 

Additional Required Materials, and combined Additional Optional Materials) in Adobe 

Pro or Adobe Pro DC. 

● Make sure you do not have any other PDF documents open. 

● Click “Tools” from the Adobe toolbar at the top of the screen. 

● Select “Combine.” 

● Select “Combine all opened files.” 

● Once combined, the file will be renamed “Binder.” 

● Click “Save As” and rename the binder file. 

● Make a note of the location on your computer and the name of the file being saved 

for easy access. 

Submit Your Final Documents 

After completing, signing, and saving all of your PDFs, you will be ready to submit them to 

OCS as your official FY21 Tribal Plan and Application package. (Detailed instructions can 

be found on page 24 of this guide.) 

 

Ask for help anytime! 

The CSBG Tribal T/TA team is here to help. Please contact us directly if you have any 

questions as you complete your Tribal Plan and application materials. You can reach us at 

(301) 244-3557 or tribalta@luxcg.com.  

mailto:tribalta@luxcg.com
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   OLDC Access  

As you prepare to use the CSBG Tribal Plan Fillable-PDF tool, please review the following 

instructions and gather the information you will need to complete each item. 

New Accounts & Renewals 

Current CSBG Grant Administrators: Login to the OLDC System and confirm that CSBG 

is listed as one of your programs. If you need CSBG added to an existing OLDC account, 

are requesting a role change, or your contact information needs to be updated please 

complete an OLDC Access Form and submit to Niki Frazier at nikita.frazier@acf.hhs.gov. 

If you are unable to log in, you can reset your password in OLDC or request this action 

from Niki Frazier at nikita.frazier@acf.hhs.gov. (For more information on accessing the 

OLDC System, please review our Guide to the OLDC System webinar materials.) 

New CSBG Administrators (Current Grantees): To gain access to the OLDC, new 

administrators of current CSBG grantees must complete an OLDC Access Form and email 

it to Niki Frazier at nikita.frazier@acf.hhs.gov. 

Prospective Grantees: Any Federally or State-recognized Indian Tribe or Tribal 

Organization that is interested in receiving CSBG funds directly must first contact the 

Office Community Services at csbgtribes@acf.hhs.gov to receive specific instructions. 

First-time applicants/prospective grantees will then submit the following before completing 

a CSBG Tribal Plan and Application: 

● Employer Identification Number (EIN) Number; and 

● A signed statement of agreement between the Tribe or Tribal Organization and the 

State confirming the Tribal population and the percentage of Tribal poverty in the 

state. 

 

  

https://csbgtribalta.com/tools/#1570647824255-6bc35c05-4007
https://csbgtribalta.com/wp-content/uploads/2018/03/OLDC-Access-Form-8.2016.pdf
mailto:nikita.frazier@acf.hhs.gov
mailto:nikita.frazier@acf.hhs.gov
https://csbgtribalta.com/oldc/
https://csbgtribalta.com/wp-content/uploads/2018/03/OLDC-Access-Form-8.2016.pdf
mailto:nikita.frazier@acf.hhs.gov
mailto:csbgtribes@acf.hhs.gov
https://csbgtribalta.com/wp-content/uploads/2018/08/Template-State-Concurrence-on-Population-Data-Final-10.1.18.docx
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   CSBG Tribal Plan & Application Materials  

SF-424M 

(Page 3 of the CSBG Tribal Plan & Application Fillable-PDF Tool.) 

SF-424M Form: All grantees must provide updated SF-424M Form with their application 

materials. (Including those grantees in the middle of a two-year plan.) 

Renewing Grantees: Renewing current grantees will complete the SF-424M Form 

information via the OLDC System. We recommend using Google Chrome for 

increased usability. Please use the following instructions: 

● Program Name: Select - Community Services Block Grant 

● Grantee Name: Enter - Name of Tribe or Tribal Organization 

● Report Name: Select - Mandatory SF-424M 

● Report Period: Enter - Current Fiscal Year (10/01/20–09/30/21) 

Select the needed “Action” on the row corresponding with the correct reporting period. 

 

● To Initiate Report: Select the plus sign icon  

● To Edit Report: Select the paper and pencil icon  

● To Revise Report: Select the paper icon  

OLDC will then prompt you for additional information. Please use the following 

instructions: 

For a one-year plan (FY21 only): 

https://csbgtribalta.com/wp-content/uploads/2018/03/SF424_Mandatory_1_2-V1.2.pdf
https://home.grantsolutions.gov/home/
http://www.google.com/chrome
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● 1.a  Type of Submission: Select - Plan 

● 1.b  Frequency: Select - Annual 

● 1.c  Consolidated Application Plan Request: Ignore section 

● 1.d  Version - Select Initial 

For a new two-year plan (FY21 and FY22): 

● 1.a  Type of Submission: Select - Plan 

● 1.b.  Frequency: Select – Other 

○ Under “Other - Specify” write “Two-year Plan FY 2021 and FY 2022” 

● 1.c  Consolidated Application Plan Request: Ignore section 

● 1.d  Version - Select Initial 

For the second year of a two-year plan (FY20 of a previously approved two-year 

plan): 

● 1.a  Type of Submission: Select - Plan 

● 1.b.  Frequency: Select – Other 

○ Under “Other - Specify” write “Year Two of Two-year Plan” 

● 1.c  Consolidated Application Plan Request: Ignore section 

● 1.d  Version - Select - Update 

For further instructions on completing the SF-424M form and uploading your 

application materials in OLDC System, please review our Guide to the OLDC System 

webinar recording.  

Prospective Grantees: Follow the instructions provided by your OCS Program 

Specialist after submitting your Employer Identification Number (EIN) Number and 

signed Tribal-State statement of agreement regarding population and poverty 

numbers. 

Section 1 - CSBG Tribal Administrative Information 

(Page 3 of the CSBG Tribal Plan & Application Fillable-PDF Tool) 

1.1. Name of Tribe or Tribal Organization 

1.1.a. Fiscal years covered by the plan 

1.2. Transmittal Letter: The Transmittal Letter is a signed letter that includes: 

https://csbgtribalta.com/oldc/
https://csbgtribalta.com/wp-content/uploads/2020/05/Template-State-Concurrence-on-Population-Data.pdf
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1.2.a Name of Tribe or Tribal Organization 

1.2.b Fiscal years covered by the plan 

1.2.c Name and contact information for the Tribe or Tribal Organization’s 
Authorized Official who would receive the CSBG Grant Award. 
(Example: Chairman, Chief, CEO, etc.) 

1.2.d Name of Authorized Tribal Official 

1.2.e Title of Authorized Tribal Official 

1.2.f Street address of Authorized Tribal Official 

1.2.g City, State, and Zip Code of Authorized Tribal Official 

1.2.h Telephone number of Authorized Tribal Official 

1.2.i Fax number of Authorized Tribal Official 

1.2.j Email address of Authorized Tribal Official 

1.2.k Website for Tribe/Tribal Organization 

1.3. Tribal CSBG Program Contact Person 

1.3.a Name the Tribe or Tribal Organization’s CSBG Tribal Program Contact 
who will administer the CSBG program. (This is a contact person in 
your Tribe or Tribal Organization who will interact with OCS and the 
CSBG T/TA Program throughout the year.) 

1.3.b Title of CSBG Tribal Program Contact 

1.3.c Street address of CSBG Tribal Program Contact 

1.3.d City, State, and Zip Code of SBG Tribal Program Contact 

1.3.e Telephone number of CSBG Tribal Program Contact 

1.3.f Fax number of CSBG Tribal Program Contact 

1.3.g Email address of CSBG Tribal Program Contact 
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1.4. Delegation of Authority 

(If appropriate) The delegation of authority made by the Chairperson/Chief/CEO of 

the Tribe or Tribal Organization to another person to certify the plan on their behalf. 

(This individual is allowed to sign all application documents requiring a CEO 

signature). Please Note: The designation should be updated whenever there is a 

change to the designee. 

1.4.a Name of Authorized Tribal Official 

1.4.b Title of Authorized Tribal Official 

1.4.c Telephone number of Authorized Tribal Official 

1.4.d Email address of Authorized Tribal Official 

1.5. Chairperson/Chief/CEO Signature 

1.5.a Name of Tribe 

1.5.b Name of Chairperson/Chief/CEO 

1.5.c Title of the Chairperson/Chief/CEO 

1.5.d Signature of Chairperson/Chief/CEO (Follow instructions on Page 5 of 

this guide for adding electronic or manual signatures.) 

Section 2 - Tribal Resolution & Federal / State Recognition 

(Page 8 of the CSBG Tribal Plan & Application Fillable PDF-Tool) 

2.1.  Tribal Resolution: A Tribal organization representing more than one Indian 

Tribe will be eligible to receive block grant funds on behalf of a particular Tribe 

only if the Tribe has by resolution authorized the organization’s action. Current 

signed and dated copies of the Tribal Resolutions granting authority for a Tribe 

or Tribal Organization to seek and administer CSBG funding must be included 

in the application. 

2.2.  Federal or State Recognition: All Tribes must provide documentation 

verifying the Federal or State recognition of the Tribe or Tribal organization 

covered by this plan. 
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2.2.a Documentation for Tribes with Federal recognition includes providing 

the full name of the Tribe or Tribal Organization as it appears in the 

U.S. Federal Register list of Indian Entities Recognized by and Eligible 

To Receive Services From the United States Bureau of Indian Affairs, 

published on 02/01/2019. 

2.2.b Documentation for Tribes without Federal Recognition must include 

proof of their State recognition. This proof includes providing a link to 

proof of State Recognition or citation information for the State statute or 

code acknowledging State Recognition. 

Section 3 - CSBG Tribal Plan Mission, Goals, and Objectives 

(Page 9 of the CSBG Tribal Plan & Application Fillable-PDF Tool) 

3.1.  Mission and Responsibility: A description of the mission and responsibilities 

of the agency or department within the Tribe or Tribal Organization that will 

administer the CSBG program. 

3.1.a. CSBG Goals and Objectives: A description of the CSBG-specific goals 

and objectives for the proposed CSBG funding within the Tribe or Tribal 

Organization. 

Section 4 - Public Hearing Requirements 

(Page 11 of the CSBG Tribal Plan & Application Fillable-PDF Tool) 

4.1.  Evidence of Public Hearing: The application must show evidence that the 

Tribe or Tribal Organization made the CSBG Tribal Plan available for public 

review and comment in conjunction with the development of the plan as 

required under Section 676(e)(2) of the CSBG Act. This includes providing the 

date, time and location the actual hearing took place. 

4.1.a. The Tribe or Tribal Organization will attach a copy of their Public 

Hearing announcement in the OLDC system. 

  
Figure 1. Screenshot of 4.1.a in the CSBG Tribal Plan Fillable-PDF Tool 

https://www.federalregister.gov/documents/2019/02/01/2019-00897/indian-entities-recognized-by-and-eligible-to-receive-services-from-the-united-states-bureau-of
https://www.federalregister.gov/documents/2019/02/01/2019-00897/indian-entities-recognized-by-and-eligible-to-receive-services-from-the-united-states-bureau-of
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Section 5 - Use of Funds and Fiscal Controls 

(Page 13 of the CSBG Tribal Plan & Application Fillable PDF Tool) 

5.1.  Planned CSBG Allocation Funds: According to the CSBG Act, not more than 

five (5) percent can be allocated to administrative items, and not less than 95 

percent can be allocated to program funds. The planned allocation in percent 

for Administrative and Program CSBG funding must be provided. If this is a 

two-year plan, the planned allocations for both years must be provided. 

  
Figure 2: Screenshot of 5.1 in the CSBG Tribal Plan Fillable-PDF Tool  

5.2.  Limitation on the Use of Funds: The Tribe or Tribal Organization 

acknowledges and assures that they will abide by the CSBG limitations 

outlined in Section 678F of the CSBG Act as follows: 

 Funds will not be used “for the purchase or improvement of land, or the 

purchase, construction, or permanent improvement (other than low-cost 

residential weatherization or other energy-related home repairs) of any 

building or other facility” without an approved federal waiver. (View 

instructions in Section 678F of the CSBG Act for information on waivers 

for construction.) 

5.3.  Single Audit Review: The date and the period (timeframe) that the most 

recent audit covers. 

   
   Figure 3: Screenshot of 5.3 in the CSBG Tribal Plan PDF Tool 

https://www.acf.hhs.gov/sites/default/files/ocs/leg_title_iicommunity_services_block_grant_act_10271998.pdf
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Section 6 - Income Eligibility Requirements & Target Communities 

(Page 13 of the CSBG Tribal Plan & Application Fillable PDF Tool) 

6.1.  Income Eligibility Requirements & Target Communities: The CSBG 

program requires that services be provided to those who meet specific CSBG 

income guidelines. The income eligibility requirement for participants is up to 

125% of the poverty line. The following information must be provided to verify 

that funds have been used in accordance with the income guidelines. 

 

6.1.a. Income Eligibility Requirements: A description of any policy and/or 

procedures for income eligibility, such as treatment of income and 

family/household composition. 

 

6.1.b. Target Communities: A description of how the organization ensures 

that services target and benefit low-income communities, for those 

services that provide a community-wide benefit. 

 

Section 7 - CSBG Assurances & Implementation Narratives 

(Page 15 of the CSBG Tribal Plan & Application Fillable PDF Tool) 

Community Services Block Grant Assurances 

Community Services Block Grant Reauthorization Act of 1998: P.L. 105-285g 

Statement of CSBG Assurances confirm that the Tribe or Tribal Organization will read all 

sections of the CSBG Assurances (summarized below and detailed in Section 676 of the 

Community Services Block Grant Reauthorization Act of 1998: P.L. 105-285) and apply 

the Authorized Tribal Official’s signature to affirm. 

Note: Signatures will be authorized for up to two-years provided that there is not a 

change in the Authorized Official. If there is a change in Authorized Official, new 

signatures will be needed on the FY22 CSBG Tribal Plan & Application. 

7.1.  Statement of CSBG Assurances: As a part of the annual or biannual 

application and plan required by subsection 676 of Community Services Block 

Grant Act, as amended, (412 U.S.C.9901 et seq.) (The Act), the designee of 

the Chief Executive of the State hereby agrees to the Assurances in Section 

676 of the Act (summarized below and detailed in Section 676 of the CSBG 

Act). — 

  

 

 

https://www.acf.hhs.gov/sites/default/files/ocs/leg_title_iicommunity_services_block_grant_act_10271998.pdf
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 Programmatic Assurances 

 

(1) An assurance that funds made available through the grant or allotment will 

be used for at least one of the following purposes [per 676(b)1] — 

 

(A) to support activities that are designed to assist low-income families and 

individuals, including families and individuals receiving assistance under 

part A of title IV of the Social Security Act (42 U.S.C. 601 et seq.), 

homeless families and individuals, migrant or seasonal farm workers, 

and elderly low-income individuals and families: 

(i) to remove obstacles and solve problems that block the achievement 

of self-sufficiency; 

(ii) to secure and retain meaningful employment; 

(iii) to attain an adequate education with particular attention toward 

improving literacy skills of the low-income families in the community, 

which may include family literacy initiatives; 

(iv) to make better use of available income; 

(v) to obtain and maintain adequate housing and a suitable living 

environment; 

(vi) to obtain emergency assistance through loans, grants, or other 

means to meet immediate and urgent individual and family needs; 

(vii) to achieve greater participation in the affairs of the communities 

involved, including the development of public and private grassroots 

partnerships with local law enforcement agencies, local housing 

authorities, private foundations, and other public and private partners. 

(B) to address the needs of youth in low-income communities through 

youth development programs that support the primary role of the family, 

give priority to the prevention of youth problems and crime, and 

promote increased community coordination and collaboration in 

meeting the needs of youth, and support development and expansion of 

innovative community-based youth development programs that have 

demonstrated success in preventing or reducing youth crime, such as: 

(i) programs for the establishment of violent-free zones that would 

involve youth development and intervention models (such as models 

involving youth mediation, youth mentoring, life skills training, job 

creation, and entrepreneurship programs); 

(ii) after-school childcare programs 
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(C) to make more effective use of, and to coordinate with, other programs 

related to the purposes of this subtitle. 

(2) An assurance that information provided by the Tribe will contain the 

following [per 676(b)3] — 

(A) a description of the service delivery system, for services provided or 

coordinated with funds made available through grants made under 

section 675C(a), targeted to low income Individuals and families in 

communities within the Tribe; 

(B) a description of how linkages will be developed to fill identified gaps in 

the services, through the provision of information, referrals, case 

management, and follow-up consultations; 

(C) a description of how funds made available through grants made under 

section 675C(a) will be coordinated with other Public and private 

sources; 

(D) a description of how the Tribe will use the funds to support innovative 

initiatives, which may include fatherhood initiatives and other initiatives 

with the goals of strengthening families and encouraging effective 

parenting. 

(3) An assurance that the Tribe will provide, on an emergency basis, for the 

provision of such supplies and services, nutritious foods, and Related 

services, as may be necessary to counteract conditions of Starvation and 

malnutrition among low-income individuals. [per 676(b)4] 

(4) An assurance that the Tribe will ensure coordination between anti-poverty 

programs in each community within the Tribe, and ensure, where 

appropriate, the emergency energy crisis intervention programs under title 

XXVI (relating to low-income home energy assistance) are conducted in 

such community. [per 676(b)6] 

(5) An assurance that the Tribe will permit and cooperate with Federal 

Investigations undertaken in accordance with section 678D. [per 676(b)7] 

(6) An assurance that the Tribe will participate in the Results Oriented 

Management Accountability (ROMA) System, another performance 

measure system for which the Secretary facilitated development pursuant 

to section 678E(b), or an alternative system for measuring performance 

and results that meets the requirements of that section, and a description 

of outcome measures to be used to measure performance in promoting 

self-sufficiency, family stability, and community revitalization. [per 676(b)13] 
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Administrative and Financial Assurances 

The Tribe further agrees to the following administrative assurances, as 

required under the Community Services Block Grant Act — 

(1) An assurance to prohibit any activities to provide voters and prospective 

voters with transportation to the polls or provide similar assistance in 

connection with an election or any voter registration activity as required by 

Section 678F(b)(2)(B) and (C) of the Act. 

(2) An assurance to expend for administrative expenses an amount not to 

exceed the greater of five percent of its allotment or the percentage 

represented by the ratio of $55.000 to the smallest State allotment for the 

fiscal year as required by Section 675(C)(b)(2) of the Act. 

(3) An assurance that the Tribe agrees to provide that fiscal control and fund 

accounting procedures will be established as may be necessary to assure 

the proper disbursal of the accounting for Federal funds paid to the Tribe or 

Tribal Organization under this subtitle, including monitoring the assistance 

under this subtitle. 678D(a)(1)(A) 

(4) An assurance that each Tribe that expends $750,000 or more (during the 

fiscal year) in all types of Federal financial assistance must conduct an 

audit in accordance with the Single Audit Act, P.L. 98-502 (3) U.S.C 75 and 

OMB Circular A-133 Subpart B).678D(2)(B) 

(5) An assurance that the Tribe will make each CSBG Tribal Plan or revised 

plan available for public inspection in such a manner as will facilitate public 

review of and comment on the proposed use and distribution of CSBG 

funds. [per 676(a)(2)(B) and676(e)(2)] 

Other Administrative Certifications 

The Tribe also certifies the following — 

(1) To provide assurances that cost and accounting standards of the Office of 

Management and Budget shall apply to a recipient of Community Services 

Block Grant program funds. [per 678D(a)(1)(B), as well as 2 CFR 200, 

Uniform Administrative Requirements and 45 CFR 75] 

 

7.2.  Authorized Tribal Official Affirmation Signature: These assurances will be 

valid for two years unless the organization and/or the official changes. 

 

7.2.a Name of Tribe or Tribal Organization 

 

7.2.b Name of Authorized Tribal Official 
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7.2.c Signature of Authorized Tribal Official (Follow instructions for adding 

electronic or manual signatures on Page 5 of this guide.) 

 

7.3.  Implementation of CSBG Assurances 

  

7.3.a CSBG Service Delivery System: A description of the service delivery 

system for services provided by or coordinated with CSBG funds. 

 

7.3.b CSBG Geographical Areas and Individuals: Information about areas 

and categories of individuals to be served with CSBG funds. 

 

7.3.c Method & Criteria for Distribution of Funds: A description of the 

criteria and method used for the distribution of CSBG funds. 

 

7.3.d Purpose of Funds: Tribes are required to implement at least one of the 

programmatic assurances as stated in Section 676(b) of the CSBG Act 

of the CSBG Act. Provide a description of the activities to be supported 

with CSBG funds that will address at least one of the following areas 

(for any section that is not applicable, please type N/A): 

 

7.3.d.i. Assist low-income families and individuals in removing 

obstacles that block the achievement of self-sufficiency; secure 

and retain meaningful employment; attain adequate literacy and 

education; make better use of available income; obtain and 

maintain adequate housing; obtain emergency assistance; and 

achieve greater participation in the affairs of the communities. 

 

7.3.d.ii. Address the needs of youth in low-income communities 

through youth development programs, such as programs for the 

establishment of violence-free zones and after- school childcare 

programs. 

 

7.3.d.iii. Make more effective use of, and to coordinate with, other 

programs related to the purposes of the CSBG Act (including 

welfare reform efforts). 

 

7.3.e Linkages: A description of how linkages will be developed to fill 

identified gaps in services, through the provision of information, 

referrals, case management, and follow up consultations. 

 

7.3.f Coordination with Other Public and Private Resources: A description 

of how funds made available will be coordinated with other public and 

private resources. 
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7.3.g Innovative Community and Neighborhood-based Initiatives: A 

description of how funds will be used to support innovative community 

and neighborhood-based initiatives related to the purposes of the 

CSBG, which may include fatherhood initiatives and other initiatives 

with the goal of strengthening families and encouraging effective 

parenting. 

 

7.3.h Plan for the provision of emergency services: A description of how 

the provision of emergency services will be provided with CSBG funds. 

(Optional Description) 

 

7.3.i Performance Management and Accountability System: A description 

of the outcome measures to be used to measure the performance 

CSBG specific goals and objectives in promoting self- sufficiency, family 

stability, and community revitalization. (Optional Description) 

 

 

Section 8 - Federal Certifications 

(Page 30 of the CSBG Tribal Plan & Application Fillable PDF Tool) 

Each of the four following certifications needs to be reviewed and signed by the 

Chairperson / Chief / CEO. Certifications must show signatures signed by the Chairperson 

/ Chief /CEO. If the Chairperson / Chief / CEO has delegated this responsibility, a written 

confirmation of such a delegation signed by the Chairperson / Chief / CEO must be 

indicated in the Transmittal Letter. If advance scheduling is required to obtain the 

Chairperson / Chief / CEO signatures, please schedule well in advance of the September 

1 deadline. 

Please Note: Signatures will be authorized for up to two-years provided that there is not a 

change in the Authorized Official. If there is a change in Authorized Official, new 

signatures will be needed on the FY22 CSBG Tribal Plan & Application. 

8.1 Certification Regarding Lobbying 

Review complete Certification Regarding Lobbying and insert authorized Tribal 

official signature. 

(8.1a – 8.1c) Authorized Tribal Official Signature  

 

https://csbgtribalta.com/wp-content/uploads/2018/04/CERTIFICATION-REGARDING-LOBBYING.pdf
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8.2. Certification Regarding Drug-Free Workplace Requirements 

Review complete Certification Regarding Drug-Free Workplace Requirements 

and insert authorized Tribal official signature. 

(8.2a – 8.2c) Authorized Tribal Official Signature  

8.3 Certification Regarding Debarment, Suspension, and Other Responsibility 

Matters 

Review complete Certification Regarding Debarment, Suspension, and Other 

Responsibility Matters and insert authorized Tribal official signature. 

(8.3a – 8.3c) Authorized Tribal Official Signature  

8.4 Certification Regarding Environmental Tobacco Smoke 

Review complete Certification Regarding Environmental Tobacco Smoke and 

insert authorized Tribal official signature. 

(8.4a – 8.4c) Authorized Tribal Official Signature  

Section 9 - Annual Report 

(Page 41 of the CSBG Tribal Plan & Application Fillable PDF Tool) 

Mandatory Annual Report: All renewing grantees must submit an Annual Report 

December 30 of each year (including grantees with previously-approved two-year CSBG 

Tribal Plans). The Annual Report is a narrative description of how the grantee met its 

CSBG goals and objectives and provides information on the types of projects supported 

with CSBG funding awarded in the previous fiscal year. 

9.1. The Tribe or Tribal Organization affirms that it will complete a FY20 CSBG 

Annual Report by December 30, 2020. 

 

  

  

https://csbgtribalta.com/wp-content/uploads/2018/04/CERTIFICATION-REGARDING-DRUG.pdf
https://csbgtribalta.com/wp-content/uploads/2018/04/CERTIFICATION-REGARDING-DEBARMENT.pdf
https://csbgtribalta.com/wp-content/uploads/2018/04/CERTIFICATION-REGARDING-DEBARMENT.pdf
https://csbgtribalta.com/wp-content/uploads/2018/04/CERTIFICATION-REGARDING-ENVIRONMENTAL-TOBACCO-SMOKE.pdf
https://csbgtribalta.com/tools/#AnnualReport
https://csbgtribalta.com/tools/#AnnualReport
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   Reviewing & Saving Completed Tools 

Review all sections of the CSBG Tribal Plan & Application Fillable-PDF Tool to be sure 

that all fields are complete. 

Fully complete all information and save your document before starting the signature 

process. To save, choose “File > Save As” on the Adobe Reader menu. You will then be 

prompted to choose a location to save the document. 

 

 

   Adding Signatures 

The CSBG Tribal Plan & Application Fillable-PDF Tool will request several original 

signatures for the tool to be considered complete. While it is preferred that digital 

signatures are used in simplifying the reporting process, we fully understand that some 

offices and locations may have limited access to digital signature resources. Those who 

have digital signature resources may opt to use the Electronic Signature Process. Others 

may prefer to use the Manual Signature Process. Please choose the process best suited 

to your needs in signing your documents. 

All signature lines must be signed for the application to be accepted by OCS. Signature 

lines can be found in the following sections: 

● Page 8 – line 1.5d 

● Page 18 – line 7.2c 

● Page 31 – line 8.1c 

● Page 35 – line 8.2c 

● Page 40 – line 8.3c 

● Page 41 – line 8.4c 

Detailed instructions for adding signatures to the CSBG Tribal Plan & Application Fillable-

PDF can be found on page 5 of this guide. 

  

https://csbgtribalta.com/tools/#1570647824255-6bc35c05-4007
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   Submitting the CSBG Tribal Plan & Application Materials to OCS 

Renewing applicants: Please remember that renewing grantees in the middle of an 

approved two-year plan must submit an updated SF-424M by September 1st and a CSBG 

Annual Report by December 30th each year. They do not, however, need to resubmit their 

CSBG Tribal Plan. 

● Save all documents for reference and future administrators. 

● Sign into the OLDC System. (Detailed instructions on using the OLDC System can be 

found in our Guide to the OLDC System webinar recording.) 

● Fill out the SF-424M electronic form, if you haven’t already. (Detailed instructions can 

be found on page 10 of this guide.) 

● Upload the following PDFs into the OLDC system: your completed and signed FY20 

Tribal Plan and Application, and Combined Additional Required Materials. (Detailed 

instructions on using the OLDC System, can be found in our Guide to the OLDC 

System webinar recording.) 

First-time applicants: Follow the instructions provided by your OCS Program Specialist 

after submitting your EIN and Tribal-State agreement letter. 

 

 

   Help is Available Anytime! 

Remember that help is always available anytime from the CSBG Tribal T/TA Program 

team at tribalta@luxcg.com or (301) 244-3557. 

 

https://home.grantsolutions.gov/home/
https://csbgtribalta.com/oldc/
https://csbgtribalta.com/oldc/
https://csbgtribalta.com/oldc/
mailto:tribalta@luxcg.com

